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This tutorial illustrates how to model a simple surface excavation,
consisting of a trench located near a circular tunnel, and a distributed
load directly above the tunnel. The gravity field stress option will be
used, and the analysis will be staged, by excavating the tunnel in the first
stage, the trench in the second, and adding the load in the third stage.

If you wish to skip the model process, the finished product of this tutorial
can be found in the Tutorial 04 Surface Excavation.fez data file. All
tutorial files installed with RS2 9.0 can be accessed by selecting File >
Recent Folders > Tutorials Folder from the RS2 main menu.

If you have not already done so, run the RS2 Model program by double-
clicking on the RS2 icon in your installation folder. Or from the Start
menu, select Programs — Rocscience — RS2 9.0 —» RS2.

Project Settings

Whenever we are creating a staged model, the first thing we should
always do is set the Number of Stages in Project Settings.

Select: Analysis — Project Settings
In the Project Settings dialog, select the Stages tab, enter Number of

Stages = 3. For the stage names, enter Excavate Tunnel, Excavate
Trench, Surface Load for stages 1, 2 and 3. Select OK.
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Entering Boundaries

First enter the external boundary. A surface excavation will always
Geometry require a user-defined external boundary. NOTE:

e If you select the Add External option before any excavation
boundaries have been entered, then you can immediately begin
entering coordinates.

o Ifyou select the Add External option after defining excavation
boundaries, then you will have to select the User Defined option
in the Add External boundary dialog, in order to enter

coordinates.
DI Select: Boundaries — Add External
Enter vertex[t=table,i=circle,esc=cancel]: 15 4
Enter vertex[...]: 1 4
Enter vertex[...]: -1 4
Enter vertex[...]: =10 4
Enter vertex[...]: =10 -8
Enter vertex[...]: 15 -8

Enter vertex[...,c=close,esc=cancel]: ¢

Press F2 to Zoom All.
Now enter the circular tunnel.
Q Select: Boundaries — Add Excavation

1. Right-click the mouse and select the Circle option from the popup
menu. You will see the following dialog.

Circle Options I. ? ihJ

Cirde definiton method
" Center and point on drde

@ Center and radius. Radius is: 1

Cirde to polyline conversion method

3

(@) Mumber of segments: &80 =

") Approximate segment length: | 0.1

b

2. Select the Center and radius option, enter Number of Segments =
60 and select OK.

3. You will be prompted to enter the circle center. Enter 0,0 in the
prompt line, and the circular excavation will be created.
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Now enter the rectangular trench.

Select: Boundaries — Add Excavation

Enter vertex[t=table,i=circle,esc=cancel]: 4.5 4
Enter vertex[...]: 4.5 -1

Enter vertex[...]: 6.5 -1

Enter vertex[...]: 6.5 4

Enter vertex[...,c=close,esc=cancel]: ¢
Meshing

Let’s look at the Mesh Setup dialog.

Select: Mesh — Mesh Setup

Mesh Setup 7T a X
Mesh and Discretization Settings
Mesh Type: [Graded v]
Element Type: [6 MNoded Triangles v]
Gradation Factor: 0.1
Default Mumber of Modes on All Excavations: 110
Advanced ¥
[ 1 Discretize ] [@ Mesh ] [ (0] 4 ] [ Cancel ]

Notice the default number of excavation nodes = 110. Select the
Discretize button in the dialog. The model is discretized, and the status
bar will indicate the actual number of discretizations created.

Discretizations: Excavation: 136 External: 101
NOTE:

e The number of excavation discretizations is 136, but 110 was entered
in the Mesh Setup dialog. Depending on your excavation geometry,
the discretization algorithm will not always give you exactly the
Number of Excavation Nodes you entered in Mesh Setup.

e Notice that RS2 automatically grades the discretization on the
external boundary, according to the distance from excavation
boundaries. The discretization on the ground surface is finer near the
top of the trench, and is gradually graded more coarsely towards the
left and right edges of the model. The discretization along the left,
right and bottom edges of the external boundary, is much coarser
than along the top edge near the excavations.
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Loads & Restraints

Surface Excavation Tutorial 4-4

Now let’s generate the mesh. Select the Mesh button in the dialog, and
select OK. The mesh is generated based on the discretization you just
created. The status bar will indicate the total number of nodes and
elements in the mesh.

ND: 3812 EL: 1855
Note that the automatically graded discretization along the ground

surface helps to create a smooth transition between the fine mesh at the
top of the trench, and the rest of the ground surface.

Boundary Conditions

Select the Loads & Restraints workflow tab.

By default, when the mesh is generated, all nodes on the external
boundary are given a fixed, zero displacement boundary condition. This is
indicated by the triangular “pin” symbols which you can see at each node
of the external boundary.

Since this is a surface excavation model, we must specify that the ground
surface is a free surface. This is done using the Free option in the toolbar

or Displacements menu.

Select: Displacements — Free

Select boundary segments to free [enter=done, esc=cancel]: Use
the mouse to select the five segments representing the ground
surface. When finished, right-click and select Done Selection,
or press Enter.

The triangular pin symbols should now be gone from the ground surface
indicating that it is free to move without restraint.

FREE

FIXED X FIRED X

Displacement boundary conditions on external boundary.
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Let’s now specify the left and right edges of the external boundary as
fixed in the X direction only (i.e. free to move in the Y direction) and the
lower edge as fixed in the Y direction only (i.e. free to move in the X
direction).

Select: Displacements — Restrain X

Select boundary segments to restrain in the X direction
[enter=done,esc=cancel]: Use the mouse to select the left and
right edges of the external boundary. Right-click and select
Done Selection, or press Enter.

Select: Displacements — Restrain Y

Select boundary segments to restrain in the Y direction
[enter=done,esc=cancel]: Use the mouse to select the bottom
edge of the external boundary. Right-click and select Done
Selection, or press Enter.

Now we have some tidying up to do — the nodes at the bottom corners
have rollers, and they should be pinned.

Select: Displacements — Restrain X,Y

1. Right-click the mouse and select Pick by Boundary Nodes from
the popup menu. This will change the mode of restraint
application from boundary segments to boundary nodes.

2. Select the lower left (-10, -8) and lower right (15, -8) vertices of
the external boundary.

3. Right-click and select Done Selection. Triangular pin symbols
now replace the roller symbols at these vertices.

This brings us to an important point — after applying restraints to
boundary segments, you should always check that nodes at the ends of
segments have the correct conditions applied.

TIP: you can also apply restraints directly by right-clicking on segments
or nodes and selecting a restraint option from the popup menu.

Adding a Distributed Load

Now let’s add a uniform distributed load to the ground surface segment
above the tunnel.

Select: Loading — Distributed Loads — Add Uniform Load
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. \
Add Distributed Load (2 [

Orientation

Magnitude {MM/m2) : 0.2
@ Mormal to boundary

) Vertical (+ve down)

Horizontal (+ve right)
' Stage Load Stage Factaors. ..
) Angle from horizontal [ 2=E
~) Angle to boundary

" Field stress vector

~) Induced stress

[ QK ] l Cancel I

L

In the Add Distributed Load dialog, enter a Magnitude = 0.2 MN/m2.
Select the Stage Load checkbox, and select the Stage Factors button.

In the Stage Factors dialog enter Factor = 0 for Stage 1 and Stage 2, and
Factor = 1 for Stage 3. Select OK in both dialogs.

[ |
Stage Factors li_E-J
Stage Factor

1 0
2 0
3| 1

Because of the Factors we have defined, the load will only be applied in
the third stage of the analysis, and will not exist in the first or second
stages. Factor = 1 means the magnitude will be the same as entered in
the Add Distributed Load dialog. Factor = 0 means no load will be applied
at that stage. Other values of Factor can be used to increase or decrease
the magnitude of a load at any stage of a model.

Now select the external boundary line segments to be loaded:

Select boundary segments [enter=done,esc=cancel] : use the
mouse to select the external boundary line segment directly
above the circular tunnel. Right-click and select Done
Selection, or press Enter.

Viewing the Load

To view the load, select the Stage 3 tab. Since we only applied the load in
Stage 3, it is only visible in Stage 3. For display purposes, the size of the
load arrows can be scaled by the user in the Display Options dialog. This
is left as an optional exercise. Since we are not finished modeling, select
the Stage 1 tab again.
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Distributed load added to model

Field Stress

For most problems involving a ground surface, we will want to use a
gravity stress field.

Select: Loading — Field Stress

-
Field Stress Properties

=)

[7]Uge actual ground surface || Use effective stress ratio [ | Use variable stress ratio

ol ]
Ground Surface Elevation {m): 4 E
Unit Weight of Overburden (MN/m3): 0.02
Total Stress Ratio (horizfvert in plane): 0.5
Total Stress Ratio (horizfvert out-of-plane): 0.5
Locked-in horizontal stress (in plane) (MPa, Comp. +) : ] Sl
Locked-in horizontal stress (out-of-plane) (MPa, Comp. +) : 0 Advanced =

Enter the above parameters and select OK. Note:

o The Ground Surface Elevation is indicated by a horizontal dotted
line, and corresponds to the y-coordinate of the top surface of the
external boundary (4 meters). The display of this line can be toggled
on or off at any time in the View menu.

e For a gravity field stress, the stress block reflects the in-plane
horizontal/vertical stress ratio, which in this case is 0.5.

e The Unit Weight of Overburden indicates that our material is a soil,
rather than rock.
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Properties

TE e S SEa Select the Materials and Staging workflow tab.
Select Define Materials from the toolbar or the Properties menu.
7] Select: Properties — Define Materials
With the first material selected, under the Strength tab enter the

following: Name = till, Unit Weight = 0.02, Friction Angle (peak) = 38,
Cohesion (peak) = 0.01.

5
Define Material Properties u—J@ e

D

O Material 2

O Material 3 )

Name: il Material Color: -
O Material 4
00 Material 5 Initial Element Loading: Uit Weight: (MN/m3): 0.02

Strength ‘ Stiffness I Datum Dependency I Stage Facborsl

Failure Criterion: | Mohr Coulomb - Material Type:

Tensile Strength (peak) (MPa): a
Fric. Angle (peak) (deg.): 33
Cohesion (peak) (MPa): .01

Under the Stiffness tab enter:

Strength | Stiffness |Da11.|m Dependency I Stage Facborsl

Type: [ISD?OIJ'C 'l Poisson's Ratio: 0.25
Young's Modulus (MPa): 50
Note:

e the Unit Weight of the material is the same as the Unit Weight of
Overburden entered in the Field Stress dialog.

e The modulus and strength values we entered are those of a till with
high frictional strength.

e For gravity field stress, the default setting for ‘Initial Element
Loading’ (in the Define Material Properties dialog) is ‘Field Stress
and Body Force’. Because we are dealing with a surface excavation
and a gravitational stress field, the body force component of loading
on each element is significant. (For a Constant stress field, the body
force component is usually not considered, and the default ‘Initial
Element Loading’ is ‘Field Stress Only’).
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What to assign:
EI Materials

Available properties:

O il

O Material 2
O Material 3
O Material 4
O Material 5

[} Excavate

[ This stage only
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Since we defined the properties with the first material selected, we do not
have to assign them to the model. By default, RS2 automatically assigns
the properties of the first material to all finite elements. We do however,
have to assign the staging of the excavations.

Select: Properties — Assign Properties

We will excavate the tunnel in Stage 1, and the trench in Stage 2, as
follows:

1. Make sure the Stage 1 tab is selected (at the bottom left of the
view).

2. Select the “Excavate” button in the Assign dialog.

3. Click the left mouse button inside the circular tunnel. The
elements in the tunnel will disappear, indicating that the tunnel
is ‘excavated’.

4. Select the Stage 2 tab.

5. Click the left mouse button inside the rectangular trench. The
elements in the trench will disappear, indicating that it is

‘excavated’.

That’s all that is required. Close the Assign dialog by selecting the X in
the upper right corner of the dialog.

As an optional step, it’s always a good idea to verify the assignments by
selecting each Stage tab in turn and inspecting the model.

e Select Stage 1 — only the tunnel should be excavated.
o Select Stage 2 — both the trench and tunnel should be excavated.

o Select Stage 3 — the distributed load should now appear above the
circular tunnel.

You can use the Stage tabs at any time to view the stages of your model,
and verify material assignments, and excavation and support sequencing.

We have now completed the modeling, your finished model should appear
as shown below.
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Finished model — RS2 Surface Excavation Tutorial

Compute

Before you analyze your model, save it as a file called surfacel.fez.
H Select: File — Save

Use the Save As dialog to save the file. You are now ready to run the
analysis.

== Select: Analysis — Compute
The RS2 Compute engine will proceed in running the analysis. When
completed, you will be ready to view the results in Interpret.
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To view the results of the analysis:
Select: Analysis — Interpret

This will start the RS2 Interpret program.

Sigma 1

You are now viewing the Sigma 1 contours for Stage 1. Toggle the
principal stress trajectories on by selecting the Stress Trajectories button
in the toolbar.

As you can see, the gravitational stress field results in horizontal Sigma 1
contours, except where the contours are perturbed by the excavation.
Overall, the major principal stress is vertical as can be seen by the ‘long’
axis of the stress trajectories — remember our horizontal / vertical stress
ratio was 0.5 (in-plane and out-of-plane).

Now view the stress contours for Stage 2 and then Stage 3, by selecting
the stage tabs at the lower left of the view.

o )

ot
C - Qlo[®RE Q= st J¥E e v o | MV-a WKW KER @[]
v EFE-EHaE-3 [/ \A[Z02[0Oo|E- A0 :[v-

T TATY TN Encavate Tunnel £ 2 Excavets remeh 3 Surfaoe o3z

ForHelp press 1 DATATIPSOFF  SNAP GRID ORTHO OSNAP 0358, 5687

Sigma 1 contours and principal stress trajectories. Gravitational field
stress is in effect.

Toggle the display of stress trajectories off by re-selecting the Stress
Trajectories toolbar button.

Select the Stage 2 and Stage 3 tabs to view the changing stress
distribution with excavation of the trench and loading.
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Strength Factor

Change the data type to Strength Factor, and change the number of
Contour intervals to 7 in the Contour Options dialog.

Strength Factor ‘ -

Select:

Based on the Strength Factor contours at Stage 3, it is evident that this
excavation would collapse without support. Keeping in mind that our
analysis was elastic, notice the regions of failure around the tunnel, and
between the trench and the tunnel (i.e. contours with strength factor < 1
in orange, and tension zones in red).

|| O jes
LTel|
~~~~~~~~ Si[o n o G [#M[NV-Q VKWW W @[22
!EII E\/\L\/OO\DO\L\AZ‘E‘DH'L\/

DATATIPS OFf  SNAP GRID ORTHO OSNAP

Strength factor contours at Stage 3, indicating collapse of material around
excavations.

Displacement

Now let’s look at displacements.

A Tatal Displacement ‘ -
Select:

View the displacement contours at each stage, by selecting the stage tabs.
Observe the maximum displacement, displayed in the status bar, and
where it is occurring on the model.

The Stage 1 maximum displacement, about 3 mm, is occurring at the
bottom of the tunnel. The Stage 2 maximum displacement, about 4.7 mm,
is occurring at the left side of the trench. The Stage 3 maximum
displacement, about 17 mm, is underneath the distributed load.
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Now let’s turn off the display of the contours, and view the deformed
shape of the boundaries and mesh, magnified by a factor of 100.

Toggling contours Off is 1. Right-click the mouse and select Contour Options.
useful when you wish to
hide the contours and view 2. In the Contour Options dialog, set the Mode to Off, and select
other information, for Done.

example stress
trajectories, deformation
vectors or deformed
boundaries.

3. Right-click the mouse and select Display Options.

4. In the Display Options dialog, select Deform Mesh and Deform
Boundaries, and enter a Scale Factor of 100. Select Done.

5. Select Zoom Excavation (in the toolbar, or press F6).

6. Select the Stage 1 tab.

e

Deformed mesh and boundaries, stage 1. Displacements magnified by 100.

Notice the flattened shape of the circular tunnel, and the subsidence of
the ground surface above the tunnel. If you look carefully, you will notice
that the bottom of the tunnel has displaced slightly more than the top.
This is due to the gravity stress field, which of course increases with
depth.

7. Select the Stage 2 tab.
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b

e

Deformed mesh and boundaries, stage 2. Displacements magnified by 100.

The deformation of the trench boundaries is clearly visible. Notice that
the excavation of the trench has shifted the displacement of the tunnel
towards the right.

8. Select the Stage 3 tab.

The displacements are now dominated by the effect of the load. The
maximum displacement is directly beneath the load. The overall
displacement of the tunnel has been shifted downward, and the bottom of
the tunnel is now almost in its original position.

0z 0z 0z 02 %

e

Deformed mesh and boundaries, stage 3. Displacements magnified by 100.
Let’s “animate” the results. First, set the timing of the animation.

Select: Data — Stage Settings
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In the Stage Settings dialog, set the Minimum Animation Time to 2
seconds. Select OK.
Now select the Animate Tabs option.
Select: Data — Animate Tabs

The stage tabs are now automatically selected for you, giving you an
animated display of results at each stage.

To exit the animation mode, press Escape.
Before we move on:

e Display the contours again. Right-click the mouse and select
Contour Options. Set the Mode to Filled and select Done.

e Also turn off the display of the Mesh and Deformed Boundaries,
by selecting the corresponding buttons in the toolbar.

e Ifyou are not already zoomed in, press F6 to Zoom Excavation.

Query Data

RS2 allows you to query data anywhere in the material to obtain values
interpolated from the contour plots. These values can be displayed
directly on the model, or graphed. A query can be a single point, a line
segment, or any arbitrary polyline.
The following steps will illustrate how to:
e Create a query, and show the values on the model
e Graph the query with data from multiple stages on the same plot
e Edit the query

Creating a Query

To create a query:
Select: Query — Add Material Query

1. It will be handy to use the Snap option in this case, so right-click
the mouse and make sure Snap is on.

2. When you are in Snap mode, if the cursor is near a model vertex,
a circle will appear around the vertex, indicating that if you click
the mouse, you will “snap” exactly to the location of the vertex.

3. Use the mouse to select the vertex at (4.5, 4) 1.e., the upper left
corner of the trench.
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Use the mouse to select the vertex at (4.5, -1) i.e., the lower left
corner of the trench.

Right-click the mouse and select Done. You will see the following
dialog:

@ At

Generate Values

() At each vertex
(") At each vertex, and at 5 | points evenly spaced along EACH SEGMENT

Show queried values  [—| Show ID Number [ oK l [ Caniel

10 | |ocations, evenly spaced along the ENTIRE palyine

Choose the options shown above, and select OK.

6.

You should now see 10 values along the left edge of the trench,
since we entered 10 locations in the Specify Query locations
dialog. (If you are not zoomed in, select Zoom Excavation to get a
better view).

The values correspond to the stage and the data type you are
viewing. Select the stage tabs, and observe the change in the
values.

Select different data types (e.g., Sigma 1, Strength Factor), and
observe the change in values.

Number of Decimal Places Displayed

The number of decimal places used to display the query values can be
customized by the user in the Legend Options dialog.

1.

If you changed data types as suggested above, switch back to
viewing Total Displacement, at Stage 2.

If the Legend is currently displayed, right-click on the Legend
and select Legend Options.

(If the Legend is NOT currently displayed, then select Legend
Options from the View menu, and select the Show Legend
checkbox in the Legend Options dialog.)

In the Legend Options dialog, select Number Format = Decimal,
and use the mouse to change the number of decimal places (click
on the up or down arrows). Notice that as the number of decimal
places is changed, the display of values on the query, and also the
interval values in the Legend, is immediately updated.

RS2v.9.0
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5. Set the number of decimal places to 4, and select OK in the
Legend Options dialog.

NOTE: the number of decimal places can be independently specified for
each data type, and RS2 will “remember” this information, so you do not
have to reset the number of decimal places each time you use the
program.

Graphing a Query

A short cut for graphing data for a single query, is to right-click on the
query and select Graph Data.

1. Right click on the query (i.e., anywhere along the left edge of the
trench), and select Graph Data from the popup menu.

2. You will see the Graph Query Data dialog.

Graph Query Data M

Vertical Axis: [Quer}-I Data ']
Horizontal Axis: ’Dismnce along guery "]
Stages to Plot
[7]1. Excavate Tunnel
2, Excavate Trench
7l 3. Surface Load
[ Select all ] ’ Clear all ]
’_—';g Copy Data ] [[ﬂ, Plat ] ’ Cancel ]

3. Select the Stages to Plot checkboxes for Stage 2 and Stage 3.
Select the Plot button, and a graph of Total Displacement along
the query, for both Stage 2 and Stage 3, will be generated.
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Trench wall displacement, before and after adding surface load.

This graph shows the “before” and “after” effect of the distributed load on
the displacement of the trench wall. The upper curve represents the
Stage 3 results, and the lower curve represents the Stage 2 results. The
maximum difference is about 3 mm, at about 3.3 meters below the ground
surface.

Note that each curve on the graph has 10 points. This is because when we
created the query, we only specified 10 locations at which to generate
values, in the Specify Query Locations dialog. We can change the number
of points to obtain a smoother graph. Close the graph. We will now edit
the query and generate a new graph.

Editing a Query

To edit the query:

1. Right click on the query, and select Edit Locations from the popup
menu.

2. You will see the Specify Query Locations dialog again. This time
enter 50 as the number of locations. Also, toggle off the “Display
queried values” checkbox. Select OK.

3. Notice the values are no longer displayed on the model. Since we
are now querying at 50 locations, the numbers would not be
readable without zooming in, so we decided to toggle them off.

4. Now repeat the steps outlined in the previous section (Graphing a
Query) to obtain a new, smoother graph with 50 points on each
displacement curve.
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Trench wall displacement using 50 query locations

Finally, note that the axis ranges and titles can be modified by right-
clicking on the graph and selecting Chart Properties. Many other chart
options are also available in the right-click menu. This is left as an
optional exercise for the user to complete.

Close the view of the graph by selecting the X in the upper right corner of
the view.

That concludes this tutorial, further exercises based on this model are
suggested below.

Single Stage Model

Although this tutorial model was set up as a three stage analysis, it could
also have been set up as a single stage model. The staging was done for
purposes of illustration, and to allow us to see the intermediate stage
results.

As an exercise, re-do this problem as a single stage model. Hints:

¢ you do not have to explicitly define the trench as an excavation, it can
be defined implicitly by the external boundary, as illustrated below.

e in the Mesh Setup option, use Number of Excavation Nodes = 60,
since the only ‘excavation’ in this model (according to the RS2
boundary definitions) is the circular tunnel, which has 60 segments.
After you Discretize, you will have to do some Custom discretizing of
the trench boundaries and adjacent segments, to obtain a mesh
similar to the one shown below.
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Surface excavation model, single stage version.

When you run the analysis, the results should be virtually identical to the
third stage results presented in this tutorial, since the analysis in both
cases is elastic. If we were doing a plastic analysis, this would not
necessarily be the case.

Adding a Liner

As another exercise, add a liner to the entire circular tunnel boundary,
and re-run the analysis. Use the default liner properties (i.e. an elastic
liner, 0.1 m thickness, modulus = 30000 Mpa). For details about adding
liners to excavations, see the Support Tutorial — Step 2.

When you look at the analysis results, notice that the zone of tension
around the tunnel is reduced in the Strength Factor contour plot, and
also the displacements are reduced.

(You can add the liner to the single stage model described above, or you

can add it to the staged model, in which case you can experiment with
installing the liner at different stages).

External Boundary Distance from Excavations

If you go back and examine the contour plots (Sigma 1, Strength Factor,
Displacement) in this tutorial, you will see that the external boundary is
influencing the contours somewhat, at the left, right and bottom edges of
the boundary. For example, the Sigma 1 contours at the lower edge of the
external boundary should be horizontal for a gravity stress field, but they
are not. This tells us that the external boundary is too close to the
excavations, and is actually restricting movement.

Re-do the staged analysis with a larger external boundary. For example,
in the following figure, the left, right and bottom edges are located at x =
—20, x =25, and y = —18, respectively.
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Modified external boundary for surface excavation tutorial.

You will find that:

e The Sigma 1 contours become horizontal at a certain distance

below the excavations, which is appropriate for a gravity stress
field.

e The maximum displacements are greater at each stage, as
indicated in the table below.

ORIGINAL EXTENDED

BOUNDARY BOUNDARY
Stage 1 .0030 .0036
Stage 2 .0047 .0065
Stage 3 .0178 .0191

Maximum displacement (m) at each stage, for original and extended
external boundaries.

In general, the extended boundary is far enough away to better simulate
‘infinite’ conditions, and should no longer influence the results near the
excavations.

RS2v.9.0 Tutorial Manual



